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Copyright and Legal Disclaimer

Copyright © 2006-2009 Dialogic Corporation. Dialogic Corporation. All Rights Reserved. You may not reproduce this document
in whole or in part without permission in writing from Dialogic Corporation at the address provided below.

All contents of this document are furnished for informational use only and are subject to change without notice and do not
represent a commitment on the part of Dialogic Corporation or its subsidiaries ("Dialogic"). Reasonable effort is made to ensure
the accuracy of the information contained in the document. However, Dialogic does not warrant the accuracy of this information
and cannot accept responsibility for errors, inaccuracies or omissions that may be contained in this document.

INFORMATION IN THIS DOCUMENT IS PROVIDED IN CONNECTION WITH DIALOGIC® PRODUCTS. NO LICENSE, EXPRESS OR
IMPLIED, BY ESTOPPEL OR OTHERWISE, TO ANY INTELLECTUAL PROPERTY RIGHTS IS GRANTED BY THIS DOCUMENT. EXCEPT
AS PROVIDED IN A SIGNED AGREEMENT BETWEEN YOU AND DIALOGIC, DIALOGIC ASSUMES NO LIABILITY WHATSOEVER,
AND DIALOGIC DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY, RELATING TO SALE AND/OR USE OF DIALOGIC PRODUCTS
INCLUDING LIABILITY OR WARRANTIES RELATING TO FITNESS FOR A PARTICULAR PURPOSE, MERCHANTABILITY, OR
INFRINGEMENT OF ANY INTELLECTUAL PROPERTY RIGHT OF A THIRD PARTY.

Dialogic products are not intended for use in medical, life saving, life sustaining, critical control or safety systems, or in nuclear
facility applications.

Due to differing national regulations and approval requirements, certain Dialogic products may be suitable for use only in
specific countries, and thus may not function properly in other countries. You are responsible for ensuring that your use of
such products occurs only in the countries where such use is suitable. For information on specific products, contact Dialogic
Corporation at the address indicated below or on the web at www.dialogic.com.

It is possible that the use or implementation of any one of the concepts, applications, or ideas described in this document, in
marketing collateral produced by or on web pages maintained by Dialogic may infringe one or more patents or other intellectual
property rights owned by third parties. Dialogic does not provide any intellectual property licenses with the sale of Dialogic
products other than a license to use such product in accordance with intellectual property owned or validly licensed by Dialogic
and no such licenses are provided except pursuant to a signed agreement with Dialogic. More detailed information about such
intellectual property is available from Dialogic's legal department at 9800 Cavendish Blvd., 5th Floor, Montreal, Quebec, Canada
H4M 2V9. Dialogic encourages all users of its products to procure all necessary intellectual property licenses required to
implement any concepts or applications and does not condone or encourage any intellectual property infringement and
disclaims any responsibility related thereto. These intellectual property licenses may differ from country to country and it is
the responsibility of those who develop the concepts or applications to be aware of and comply with different national license
requirements.

Dialogic, Dialogic Pro, Brooktrout, Diva, Cantata, SnowShore, Eicon, Eicon Networks, NMS Communications, NMS (stylized),
Eiconcard, SIPcontrol, Diva ISDN, TruFax, Exnet, EXS, SwitchKit, N20, Making Innovation Thrive, Connecting to Growth, Video
is the New Voice, Fusion, Vision, PacketMedia, NaturalAccess, NaturalCallControl, NaturalConference, NaturalFax and Shiva,
among others as well as related logos, are either registered trademarks or trademarks of Dialogic Corporation or its subsidiaries.
Dialogic's trademarks may be used publicly only with permission from Dialogic. Such permission may only be granted by
Dialogic's legal department at 9800 Cavendish Blvd., 5th Floor, Montreal, Quebec, Canada H4M 2V9. Any authorized use of
Dialogic's trademarks will be subject to full respect of the trademark guidelines published by Dialogic from time to time and
any use of Dialogic's trademarks requires proper acknowledgement.

Windows, Windows Server, and Microsoft are registered trademarks of Microsoft Corporation in the United States and/or other
countries. Other names of actual companies and products mentioned herein are the trademarks of their respective owners.
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Dialogic Corporation License Agreement for Use of Software

This is an Agreement between you, the Company, and your Affiliates (referred to in some instances as "You" and in other
instances as "Company") and all Your Authorized Users and Dialogic Corporation ("Dialogic").

YOU SHOULD CAREFULLY READ THE SOFTWARE LICENSE AGREEMENT ("AGREEMENT") ON THIS SEALED PACKAGE BEFORE
OPENING THE PACKAGE. BY OPENING THE PACKAGE, YOU ACCEPT THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF
YOU DO NOT AGREE WITH OR ARE UNWILLING TO ACCEPT THESE

TERMS AND CONDITIONS, YOU MAY RETURN THE PACKAGE IN UNOPENED "AS NEW" CONDITION (INCLUDING ALL
DOCUMENTATION AND BINDERS OR OTHER CONTAINERS) FOR A FULL REFUND. BY DOWNLOADING, INSTALLING, COPYING
OR OTHERWISE USING THE ENCLOSED SOFTWARE ("PROGRAM"), YOU FURTHER AGREE AND ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT AND UNDERSTAND IT, AND THAT BY TAKING ANY ONE OR MORE OF SUCH STEPS/ACTIONS
YOU AGREE TO BE BOUND BY SUCH TERMS AND CONDITIONS. DIALOGIC IS UNWILLING TO LICENSE THE SOFTWARE TO
YOU IF YOU DO NOT ACCEPT AND AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT.

Intellectual Property

The enclosed Software ("Program") and all accompanying documentation are individually and collectively owned by Dialogic
Corporation ("Dialogic"), its subsidiaries and/or its suppliers and are protected by all applicable intellectual property laws and
international treaty provisions. Therefore, You and Your Authorized Users must treat the Program and documentation like any
other material so protected, except as expressly permitted in this Agreement. In particular, but without limitation, You
acknowledge that the Program and its accompanying documentation constitute valuable intellectual property rights, including
without limitation trade secrets and copyrights, and confidential information of Dialogic. The Program and all programs
developed thereunder and all copies thereof (including without limitation translations, compilations, partial copies with
modifications and updated works) are proprietary to Dialogic and title to all applicable copyrights, trade secrets, patents and
other intellectual property rights therein remains in Dialogic, its subsidiaries, and/or its suppliers. Except as expressly permitted
in this Agreement, You shall not sell, transfer, publish, disclose, display or otherwise make available the Program or copies
thereof to others. You agree to secure and protect the Program, its accompanying documentation and copies thereof in a
manner consistent with the maintenance of Dialogic's rights therein and to take appropriate action by instruction or agreement
with Your employees and/or consultants who are permitted access to the Program to satisfy Your obligations hereunder.
Violation of any provision of this paragraph shall be the basis for immediate termination of this Agreement. Because
unauthorized use or transfer of the Software or documentation may diminish substantially the value of such materials and
irrevocably harm Dialogic, if You breach the provisions of this Section of this Agreement, Dialogic shall be entitled to injunctive
and/or other equitable relief, in addition to other remedies afforded by law, to prevent a breach of this Section of this Agreement.

Grant of License

Subject to the terms and conditions of this Agreement Dialogic grants to You a non-exclusive, personal, non-transferable
license to use the Program in object code form only and solely in accordance with the following terms and conditions:

e You may make, install and use only one (1) copy of the Program on a single-user computer, file server, or on a workstation
of a local area network, and only in conjunction with a legally acquired Dialogic® hardware or software product You may
also make one copy solely for backup or archive purposes;

e The primary Authorized User on the computer on which the Program is installed may make a second copy for his/her
exclusive use on either a home or portable computer;

e You may copy the Program into any machine readable or printed form for backup or modification purposes in support of
Your use of one copy of the Program;

e You may distribute the Program in object code only and only as part of, or integrated by You into, a computer system that
(i) contains a Dialogic hardware product, (ii) includes a substantial amount of other software and/or hardware manufactured
or marketed by You and (iii) is marketed and sublicensed to an end user for the end user's own internal use in the regular
course of business (a "Licensed System");

e Each end user to whom a Licensed System is distributed must agree to license terms with respect to the Program that are
at least as protective of Dialogic's rights in the Program as those set forth in this Agreement;

e You shall receive one (1) Program master disk, and shall be solely responsible for copying the Program into the Licensed
Systems and for warranting the physical media on which it is copied

e You may make one (1) copy of the documentation accompanying the Program, provided that all copyright notices contained
within the documentation are retained;

e You may modify the Program and/or merge it into another Program for Your use in one computer; (any portion of this
Program will continue to be subject to the terms and conditions of this Agreement);

e You may transfer the Program, documentation and the license to another eligible party within Your Company if the other
party agrees to accept the terms and conditions of this Agreement. If You transfer the Program and documentation, You
must at the same time either transfer all copies whether in printed or machine readable form to the same party or destroy
any copies not transferred; this includes all modifications and portions of the Program contained in or merged into other
Programs;
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¢ You shall not remove, and each copy of the Program shall contain, the same copyright, proprietary, patent and/or other
applicable intellectual property or other ownership notices, plus any restricted rights legends that appear in the Program
and/or this Agreement and, if You copy the Program onto media to which a label may be attached, You shall attach a label
to the media that includes all such notices and legends that appear on the Program master disk and envelope;

e You may not rent or lease the Program. You may not reverse engineer, decompile or disassemble the Program. Except as
is strictly necessary for You to integrate the Program with other software and/or hardware to produce the Licensed Systems,
You shall not copy, modify or reproduce the Program or documentation in any way. You shall use Your best efforts to ensure
that any user of the Program does not reverse engineer, decompile or disassemble the Program to derive a source code
equivalent of the Program;

e If You transfer possession of any copy, modification or merged portion of the Program or documentation to another party
in any way other than as expressly permitted in this Agreement, this license is immediately and automatically terminated;

e The Program may be used only in conjunction with Dialogic hardware;

e The Program shall not be exported or re-exported in violation of any export provisions of the United States or any other
applicable jurisdiction.

Upgrades

If the Program is provided as an upgrade and the upgrade is an upgrade from another product licensed to You and Your
Authorized Users by Dialogic, the upgrade is governed by the license agreement earlier provided with that software product
package and the present Agreement does not grant You additional license(s).

Term

The Agreement is effective until terminated. You may terminate it at any time by notifying Dialogic and/or by destroying the
Program and all accompanying documentation together with all copies, modifications and merged portions in any form. The
Agreement will also terminate automatically upon the occurrence or lack of occurrence of certain terms and/or conditions set
forth in this Agreement, or if You fail to comply with any term or condition of this Agreement. You agree that upon any such
termination You shall destroy or return to Dialogic the Program and all accompanying documentation supplied by Dialogic,
together with any and all copies, modifications and merged portions in any form. All provisions of this Agreement relating to
disclaimers of warranties, limitation of liability, remedies, or damages, and licensor's proprietary rights shall survive
termination.

Limited Warranty

Dialogic solely warrants the media on which the Program is furnished to You to be free from defects in materials and
workmanship under normal use for a period of ninety (90) days from the date of purchase by You as evidenced by a copy of
Your receipt. If such a defect appears within the warranty period, You may return the defective media to Dialogic for replacement
without charge provided Dialogic, in good faith, determines that it was defective in materials or workmanship. Replacement
is Your sole remedy with respect to such a defect. Dialogic offers no warranty for Your reproduction of the Program. This
Limited Warranty is void if failure of the Program has resulted from accident, misuse, abuse or misapplication.

Disclaimers, Limitations of Liability and Customer Remedies

Except as set forth in the "Limited Warranty" Section of this Agreement, the Program and accompanying documentation are
provided to You "as is." Neither Dialogic, its subsidiaries, its suppliers, nor its licensor(s) (if any) warrants that the Program
will meet Your requirements or that its use will be uninterrupted or error-free. Except as set forth in the "Limited Warranty"
Section, EACH OF DIALOGIC, ITS SUBSIDIARIES, ITS SUPPLIERS AND ITS LICENSOR(S) (IF ANY) DISCLAIMS ANY AND ALL
REPRESENTATIONS AND WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THE PROGRAM AND ACCOMPANYING
DOCUMENTATION, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR AGAINST LATENT DEFECTS. Except as set forth in the "Limited Warranty" Section,
neither Dialogic, its subsidiaries, its suppliers, nor its licensor(s) (if any) shall have any liability to You or any third party for
any claim, loss or damage of any kind, including but not limited to lost business profits, business interruption, loss of
information, or other pecuniary loss and indirect, punitive, incidental, economic, consequential or special damages, arising
out of or in connection with this Agreement and/or the use, inability to use the Program and/or the Program's performance
or inability to perform nor from or in connection with the Program's accompanying documentation, or any data or equipment
related thereto or used in connection therewith. In no event shall Dialogic's, its subsidiaries', its suppliers' or its licensor(s)'s
liability for damages, whether arising out of contract, negligence, warranty, or patent or copyright infringement, exceed the
fees You paid for the Program. No representation or warranty regarding the Program may be made without Dialogic's, its
subsidiaries', its suppliers', or its licensor(s)'s (if any) prior written consent, and any warranty or representation made by You
or Your customers regarding the Program shall not constitute an obligation of Dialogic, its subsidiaries, its suppliers, or other
licensor(s) (if any). This limited warranty gives You specific legal rights. You may have other rights, which may vary from
jurisdiction to jurisdiction. Also, as some jurisdictions do not allow the exclusion or limitation for certain damages, some of
the above limitations may not apply to You.
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Right to Audit

If this Program is licensed for use in a Company, Your Company and You individually and collectively agree to keep all usual
and proper records and books of accounts and all usual proper entries relating to each installation of the Program during the
term of this Agreement and for a period of three (3) years thereafter. During this period, Dialogic may cause an audit to be
made of the applicable records in order to verify Your compliance with this Agreement and prompt adjustment shall be made
to compensate for any errors or omissions disclosed by such audit. Any such audit shall be conducted by an independent
certified public accountant selected by Dialogic and shall be conducted during the regular business hours at Your offices and
in such a manner as not to interfere with Your normal business activities. Any such audit shall be paid for by Dialogic unless
material discrepancies are disclosed. For such purposes, "material discrepancies" shall mean three percent (3%) or more of
the Authorized Users within the Company. If material discrepancies are disclosed,

Your Company agrees to pay Dialogic for the costs associated with the audit as well as the license fees for the additional
licensed channels or additional authorized users. In no event shall audits be made more frequently than semi-annually unless
the immediately preceding audit disclosed a material discrepancy.

Supplementary Software

Any Supplementary Software provided with the Program and/or referred to in this Agreement is provided "as is" with no
warranty of any kind.

Miscellaneous

You acknowledge that You have read this Agreement, that You understand it, and that You agree to be bound by its terms
and conditions, and You further agree that this is the complete and exclusive statement of the Agreement between the Dialogic
and You ("the Parties"), which supersedes and merges all prior proposals, understandings and all other agreements, oral and
written, between the Parties relating to the Program. You agree to indemnify and hold harmless Dialogic and its subsidiaries,
affiliates, suppliers, officers, directors and employees from and against any claim, injury, loss or expense, including reasonable
attorneys' fees, arising out of (i) Your failure to comply with the provisions of this Agreement, or (ii) any other wrongful conduct
by or on behalf of You. This Agreement applies to all updates, future releases, modifications and portions of the Program
contained in or merged into other programs. This Agreement may not be modified or altered except by written instrument
duly executed by Dialogic. No action, regardless of form, arising out of this Agreement or the use of the Program may be
brought by You more than two (2) years after the cause of action has first arisen. Except as provided herein, neither this
Agreement nor any rights granted are assignable or transferable, and any assignment or transfer will be null and void. If You
authorize any other person to copy the Program, You shall obligate that person in writing to comply with all conditions of this
Agreement. Dialogic shall have the right to collect from You its reasonable expenses incurred in enforcing this agreement,
including attorney's fees. The waiver or failure of Dialogic to exercise in any respect any right provided for herein shall not be
deemed a waiver of any further right hereunder. All rights and remedies, whether conferred hereunder or by any other
instrument or law, will be cumulative and may be exercised singularly or concurrently. Failure by either Dialogic or You to
enforce any term or condition of the Agreement will not be deemed a waiver of future enforcement of that or any other term
or conditions. The terms and conditions stated herein are declared to be severable. Should any term(s) or condition(s) of this
Agreement be held to be invalid or unenforceable the validity, construction and enforceability of the remaining terms and
conditions of this Agreement shall not be affected. It is expressly agreed that Dialogic and You are acting as independent
contractors under this Agreement. These terms and conditions will prevail notwithstanding any different, conflicting or
additional terms and conditions that may appear on any other agreement between Dialogic and You. Deviations from these
terms and conditions are not valid unless agreed to in writing in advance by an authorized representative of Dialogic. Any
notices sent to Dialogic under this Agreement must be sent by registered mail or courier to the attention of Dialogic's legal
department at the address below or such other address as may be listed on www.dialogic.com from time to time as being
Dialogic's Montreal headquarters.

U.S. Government Restricted Rights

The Program and all accompanying documentation are provided with RESTRICTED RIGHTS. Use, duplication or disclosure by
the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(iii) of The Rights in Technical Data and
Computer Software clause at DFARS 252.227-7013 or subparagraph (c¢) (1) and (2) of the Commercial Computer
Software-Restricted Rights at 48 CFR52.227-19, both as applicable.

Governing Law

Any and all claims arising under this Agreement shall be construed and controlled by the laws in force in the Province of
Quebec, Canada, excluding its principles of conflict of laws and the United Nations Convention on Contracts for the Sale of
Goods. Dialogic is not obligated under any other agreements unless they are in writing and signed by an authorized
representative of Dialogic.

Contractor/ manufacturer is:

Dialogic CORPORATION.
9800 Cavendish Blvd., Montreal, Quebec, Canada H4M 2V9

This Agreement has been drafted in English at the express wish of the parties. Ce contrat a été rédigé en anglais a la demande
expresse des parties.
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Dialogic Corporation End User Hardware Product(s) Warranty Statement

Unless Your rights have been modified through the direct agreement between Dialogic Corporation ("DIALOGIC") and
DIALOGIC's direct customer through whom You purchased Your DIALOGIC Hardware Product(s) Your warranty rights are set
out in full as follows:

DIALOGIC or its subsidiary that originally sold the hardware product(s) warrants to the original purchaser of the hardware
product(s) that at the time of delivery the hardware product(s) will be free from defects in material and workmanship. The
warranty period for Your hardware product(s) will be for the standard period set forth on DIALOGIC's web-site at:
http://www.dialogic.com/warranties as of the date You purchased the product. This warranty is void if the defect has resulted
from accident, misuse, abuse or misapplication. Any hardware product which becomes defective during the warranty period
and is returned by the original purchaser to DIALOGIC's Authorized Service Center with a Return Material Authorization (RMA)
number (which must be obtained from DIALOGIC before any return) within thirty (30) days after discovery of the defect and
with an accompanying written description of the defect will be replaced at DIALOGIC's option. Freight charges will be paid by
DIALOGIC only for shipment back to you.

Additional Exclusions: DIALOGIC will have no obligation to make repairs or replacements necessitated by your fault or
negligence, improper or unauthorized use of the product, repairs or modifications made without DIALOGIC's prior written
approval or by causes beyond the control of DIALOGIC, including, but not limited to, power or air conditioning failure, acts of
God, improper interface with other units, or malfunction of any equipment or software used with the DIALOGIC product(s).
If DIALOGIC is requested and agrees to make repairs or replacements necessitated by any such causes, you will pay for such
service or replacement at DIALOGIC's then prevailing rates.

No Other Warranties: DIALOGIC DISCLAIMS AND YOU WAIVE ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT AND FITNESS FOR A
PARTICULAR PURPOSE AND ANY WARRANTY AGAINST LATENT DEFECTS, WITH RESPECT TO ANY DIALOGIC PRODUCT.

No Liability for Damages: IN NO EVENT SHALL DIALOGIC OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES WHATSOEVER
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, INTERRUPTION OF ACTIVITIES, LOSS OF
INFORMATION OR OTHER PECUNIARY LOSS AND DIRECT OR INDIRECT, CONSEQUENTIAL, INCIDENTAL, ECONOMIC OR
PUNITIVE DAMAGES) ARISING OUT OF THE USE OF OR INABILITY TO USE ANY DIALOGIC PRODUCT.

Limitation of Liability: DIALOGIC'S MAXIMUM CUMULATIVE LIABILITY SHALL BE LIMITED TO THE AMOUNTS ACTUALLY PAID
BY YOU TO DIALOGIC FOR THE SPECIFIC PRODUCT BEING THE OBJECT OF THE CLAIM. YOU RELEASE DIALOGIC FROM ALL
AMOUNTS IN EXCESS OF THE LIMITATION. YOU ACKNOWLEDGE THAT THIS CONDITION IS ESSENTIAL AND THAT DIALOGIC
WOULD NOT SUPPLY TO YOU IF IT WERE NOT INCLUDED.
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Dialogic® 4000 Media Gateway Series Quickstart Guide

This document describes the installation and configuration of the Dialogic® 4000 Media Gateway Series using
the Dialogic® 4000 Media Gateway Service Update 3 software. The term "Dialogic® 4000 Media Gateways" is
used herein to refer collectively to the Dialogic® 4000 Media Gateway Series and the term "Dialogic® 4000 Media
Gateway" is used herein to refer to a gateway in the Dialogic® 4000 Media Gateway Series. This document
assumes that the user is familiar with the Windows® operating system and its configuration, and therefore it
does not describe the Windows configuration step by step.

Server System

The Dialogic® 4000 Media Gateways use an Intel IP Network Server NSW 1U-R as server system. For more
information regarding this hardware, see the Intel web site at www.intel.com.

Available Dialogic® Media Gateway Versions

The following Dialogic Media Gateways are available:

Version Media Boards installed Channels |Channels Fax Channels Dialogic® Diva®
Voice SIPcontrol™ Software
4008BRI 1 x Dialogic® Diva® 4BRI-8 PCI 8 8 8
4008LS 1 x Dialogic® Diva® Analog-8 PCI |8 8 8
4030DTIV34 |1 x Dialogic® Diva® PRI/E1/T1-30 PCI|30 30 30
4060DTI 1 x Dialogic® Diva® V-2PRI-60 PCI |60 12 - 60 (separate license 60
needed; see note below)
4060DTIV34 |1 x Dialogic® Diva® V-2PRI-60 PCI |60 60 (separate license needed; |60
see note below)
4120DTI 1 x Dialogic® Diva® V-4PRI-120 PCI 120 12 - 120 (separate license 120
needed; see note below)
4120DTIV34 |1 x Dialogic® Diva® V-4PRI-120 PCI |120 120 (separate license 120
needed; see note below)

Note: The Dialogic® 4000 Media Gateways include the option to activate a default fax license for 12 channels.
If you need more channels, you are required to purchase a license. For more information about licenses, see
License Activation on page 13.

Pre-installed Operating System
The Windows Server® 2008 R2 64-bit operating system is pre-installed on the Dialogic® 4000 Media Gateways.

Software Components

The following Dialogic® Diva® software is pre-installed on the Dialogic® 4000 Media Gateways:

« Dialogic® Diva® System Release 8.5WIN Service Update 6: It includes the necessary Dialogic® Diva® Media
Board installation, configuration, tracing, and line testing utilities.

« Dialogic® Diva® SIPcontrol™ 2.1: Itincludes the necessary SIP to PSTN gateway module installation including
a web-based gateway configuration.

Additionally, the gateways are supplied with the following Microsoft® software:
o Microsoft® Office Communications Server 2007 R2 Mediation Server

For more information about Dialogic® 4000 Media Gateways and Microsoft® Unified Communications, see
www.dialogic.com/microsoftuc. See the Dialogic web site also for any product updates.

Also, you can add Remote Call Control via third party software. Contact your Dialogic partner or the Dialogic
sales team for more information.
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General Safety Instructions

WARNING

A

page 10

e To help prevent electric shock, plug the gateway's power cables into properly grounded

electrical outlets. Do not use adapter plugs or remove the grounding prong from a cable. If
you must use an extension cable, use a three-wire cable with properly grounded plugs.

The voltage and current rating of the cable should be greater than the ratings marked on the
product.

Do not spill food or liquids on your gateway, and never operate the product in a wet
environment.

Do not push any objects into the openings of your gateway. Doing so can cause fire or electric
shock by shorting out interior components.

Never install telephone jacks in wet locations.

Never touch non-insulated telephone wires or terminals unless the telephone line has been
disconnected at the network interface.

Use caution when installing or modifying telephone lines.

Telephone companies report that electrical surges, typically lightning transients, are very
destructive to customer terminal equipment connected to AC power sources. The use of a
surge arrestor on the AC line is recommended.

Warning! Do not attempt to modify or use the supplied AC power cord if it is not the exact
type required.

Avertissement! Ne pas utiliser ni modifier le cable d'alimentation secteur fourni, s'il ne
correspond pas exactement au type requis.

Warnung! Versuchen Sie nicht, das mitgelieferte Netzkabel zu verandern oder zu verwenden,
wenn es sich nicht um genau den erforderlichen Typ handelt.

Avvertenza! Non modificare o utilizzare il cavo di alimentazione in c.a. fornito dal produttore,
se non corrisponde esattamente al tipo richiesto.

iAdvertencia! No intente modificar ni usar el cable de alimentacion de corriente alterna, si
no corresponde exactamente con el tipo requerido.

In some cases, the power cord supplied with this system may not be compatible with the AC
wall outlet in your region. If this is true, you must obtain a suitable power cord that meets
the following criteria:

e The cord must be rated for use at the AC voltage available, with a current rating that is
at least 125% of the current rating of the product (for current rating information, refer
to the regulatory label affixed to the product).

e The AC plug end must be terminated in a grounding-type male plug designed for use in
your region. The plug ends must be labeled or marked to indicate they have been certified
by an agency acceptable in your region.

e The power service must be connected through a properly grounded outlet.

e The connector at the product end must be an IEC 320, sheet C13, female connector (or
the equivalent EN 60 320 connector).

e The cord must be less than 14.8 feet (4.5 meters) long and, for use in Europe, be created
with <HAR> (harmonized) or VDE certified cordage.

e If power needs to be removed from this product, you must disconnect the power cord;
therefore, the socket-outlet shall be installed near the equipment and shall be easily
accessible.
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WARNING Rack Mounting Warnings:

A e Ifinstalled in a closed or multi-unit rack assembly, the operating ambient
temperature of the rack environment may be greater than room ambient.
Therefore, consideration should be given to installing the equipment in an
environment compatible with the maximum ambient temperature (Tma)
specified by the manufacturer.

¢ Installation of the equipment in a rack should be such that the amount of air
flow required for safe operation of the equipment is not compromised.

e Mounting of the equipment in the rack should be such that a hazardous
condition is not achieved due to uneven mechanical loading.

e Consideration should be given to the connection of the equipment to the
supply circuit and the effect that overloading of the circuits might have on
over current protection and supply wiring. Appropriate consideration of
equipment nameplate ratings should be used when addressing this concern.

e Reliable earthing of rack-mounted equipment should be maintained.
Particular attention should be given to supply connections other than direct
connections to the branch circuit (e.g. use of power strips).

INFORMATION

R

Do not open the gateway box! Otherwise the warranty voids.
e Use only power cables approved for the use in your country.

e To help protect your gateway from transient increases and decreases in
electrical power, use a surge suppressor, line conditioner, or uninterruptible
power supply (UPS).

e Keep your gateway away from radiators and heat sources. Also, do not block
cooling vents.

Dialogic® Diva® PRI Media Boards

Cables for Interface ports used for the Dialogic® 4000 Media Gateway Series
shall be shielded.
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Installation

Installation
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Take the Dialogic® 4000 Media Gateway and identify its ports:

e A: ports of the Dialogic® Diva® Media Board: The above graphic shows a Dialogic® 4120 Media Gateway;
therefore, the four ports of a Diangic® Diva® V-4PRI/E1/T1 are displayed.

Note: If you have a Dialogic® Media Gateway with a Dialogic® Diva® Analog-8 PCI Media Board installed,
the port assignation is as follows (from left to right):

.
B: power supply,
C: redundant power supply,
e D: two PS/2 ports,
E: VGA port for the monitor,
e F: two USB ports for mouse and keyboard,
e G: four Ethernet ports.
Connect the mouse and keyboard to the USB or PS/2 ports.

Connect one end of the Ethernet cable to the Ethernet port 1 and the other end to the corporate Ethernet.
For fault tolerance and load balancing, also connect a cable to Ethernet port 2 the same way. See the above
graphic above for the numbering of the ports.

Connect the monitor to the VGA port.

Plug one end of the T1/E1 cables into the ports of the Diva Media Board. Plug the other end into the ports
of the PBX. The ports of the Diva Media Board are numbered from 4 to 1 from the left to the right as shown
in the graphic above. The port numbers may be important during the software configuration.

Plug one end of the power cord into the power supply. Connect the other end to power source. Connect the
second power cord the same way. It is recommended to connect both power supplies to ensure proper
functioning of the Dialogic 4000 Media Gateway.

Switch on the Dialogic 4000 Media Gateway.

Initial Log On
The initial configuration allows the unit to be configured using a remote desktop connection.

The Dialogic® 4000 Media Gateway Series is initially configured with:

Ethernet port 1 and 2: with fixed IP address 192.168.1.1
Ethernet port 3 and 4: disabled

Note: The above numbering of the Ethernet ports refers to the numbering at the rear panel of the Media
Gateway and not to the numbering displayed in the Control Panel of your operating system.

System name: DMG4 <XXX>-<XXXXX> (4<XXX> -> XXX stand for the version number, i.e., 060 or 120,
XXXXX -> stand for the last five digits of the serial number)

User name: Dialogic
Password: Dialogic (Change the password after the initial log on.)
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Preparing for Configuration

Before you start to configure your Dialogic® Media Gateway, it is necessary to gather some information about
the environment in which it will be used.

Collect the following information:

1. In case the gateway is to be connected to a PBX: Which vendor and which PBX type will be used?

2. What protocol will be used on the PSTN/PBX side of the gateway? Examples are EuroISDN (ETSI-DSS1),
Q-SIG, and DMS100.

License Activation
If you want to use one or more of the the following functionalities:

e V.17 fax,

e \.34 fax,

e V.90 modem, or
e G.729

available with the installed Dialogic® Diva® Media Board, you need to activate a license. Together with the
Dialogic 4000 Media Gateway Series, Dialogic provides a default license for V.17 fax simultaneously on 12
channels. You need to activate the license as described below before you can use the fax feature. If you need
more channels for V.17 fax or if you want to use another of the above listed functionalities, you need to purchase
a license. Contact your Dialogic sales representative for more information.

To activate your license, you need the following information:
e Device Unigue ID (DUID) on page 13

e Proof of Purchase Code (PPC) on page 13

Once you have both, the DUID and the PPC, visit the Dialogic® Diva® Activation site to register your PPC together
with the DUID and you will receive your license file. Activate this license file in the License Manager of the
Dialogic® Diva® Configuration Manager. The Diva Configuration Manager is part of the Dialogic® Diva® System
Release software and allows you to configure your Diva Media Board. For more information about the license
activation, see To activate the license file on page 15.

Device Unique ID (DUID)

The DUID binds the license to the installed Dialogic® Diva® Media Board. You can get the DUID from the
Dialogic® Diva® Configuration Manager as described here:

1. Click Start > Programs > Dialogic Diva > Configuration Manager.
2. In the menu bar, click Tools > License Manager and click Available DUIDs on this system.

3. Inthe right pane of the dialog box, select the Diva Media Board for which you want to activate a license and
click Copy DUID to the clipboard.

4. Ifyou need to dothe web activation using another computer, open an editor, paste the DUID, and save the file.

Proof of Purchase Code (PPC)

When you purchase the license, you will receive a PPC either in printed form or via email. By registering this
PPC, you represent and warrant that you lawfully purchased the license.
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Preparing for Configuration

To register your PPC and DUID

1. Open the following web site: http://www.dialogic.com/activate.
2. Enter your PPC and click Check.

~ Diva Activation

@I o v ] Rt/ feew dislogic. com factivatefakiveb_reg.asp
Datal Bearbeiten  Ansicht Faworlten Bxfras 7

1: | Diva Activation | |

w WORLDVADE CONTALZT DEVELOPER RESOURCE CENTER

PARTNER REEOURCE CENTER | EITEMAP GO

..Dialegic

HOME PRODUCTS PURCHASE NEWS & EVENTS ABOUTUS

PARTHERS SERVICES & SUPPORT

Dialogic Diva Activation

Enter the PPC wihich you received after placing an onder, eiiher in & printed centificats, or by emal

..... E0FBESE€E4DIDICH

|

Seeing Beyond Tomorrow
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3. If your PPC is valid, the following web site will open:

Diva Activation
Datel Bearbelten Anclcht Chronlk Leseselcnen Exiras Hilfe

@@ ) @D v diglogic com/activatelakiveb regaEp =lp

* UWORLCWIOE CONTACT | DEYELOFER RESOURCE CENTER FARTMER RESOURCE CENTER | SMTEMAF GO
Dialegic

HORE PRODUCTS PURCHASE PARTNERS SERVICES & SUPPORT NEWS & EVENTS ABOUTUS

- N il .4 %) :
1 X -
P al

Dialogic Diva Activation

DEIP2000000234524402BC6341DE5E hems

Gy Code Mame
2 DM2-000 Z0.0ay Demo, Fax T.58, par charnel

The OUD distlay=d on the Activalion pege of fhe Diva Sereer configuration uiity i reguired o complete the regisiration process.

Tre DU is a numrher ks ons of fese 1253456785, 31254567630, N1 P3456788 T9-1734567 or 3-17 34567

The email adokezs that you enter bere wll b uzed for delivery of vour licenc= fie.

‘fou can enter @ comement hare which may appsar 0 the loenca e

| Activate

Paste the Device Unique ID (DUID) that you saved earlier, and enter your email address to which the license
file should be sent.

4. Click Activate to generate the license file that will be sent to the email address you have entered.

5. Save the license file and activate it as described below.

To activate the license file

Note: The date set in the system settings of your computer must be correct. Otherwise, you cannot add your
license file.

1. Open the Dialogic® Diva® Configuration Manager. To do so, click Start > Programs > Dialogic Diva >
Configuration Manager.

Click Tools > License Manager in the menu bar of the Diva Configuration Manager.
Click Add License and go to the directory where you saved the license file.
Select the license file and click Open. Your license file is now added to the License Manager.

Click Close to close the License Manager.
In the Diva Configuration Manager menu bar, click File > Activate to activate the configuration.

o nrwNR

Now, the fax functionality you acquired with your license is unlocked.

page 15



Basic Configuration

Basic Configuration
Configure the connection to the PSTN/PBX line in the Dialogic® Diva® SIPcontrol™ Software web interface.
1. Click Start > Programs > Dialogic Diva > SIPcontrol Configuration to open the web interface.

2. In the Diva SIPcontrol software web interface, click Board configuration on the left hand side. A page
displaying all installed Diva Media Boards will open:

- -
Dialegic
] HOME Board Configuration
ilable Diva Boards
@ Configuration
n Board 2
Board configuration b Dialogic Diva 4BRI-8 PCIv2 - FORT 1 8N:
SIPcontrol configuration 10054
Fassword
Board 3
Dialogic Diva 4BRI-8 PCIv2 - FORT 2 81:
ii System 10054
Serwice status
Board 4
Dialogic Diva 4BRI-8 PCIv2 - FORT 3 81:
10054
Status
Board manitar Board 5
View report Dialagic Diva 4BRI8 PCIv2 - PORT 4 SN;
10054

icensng RN

License management

3. To configure Diva Media Board parameters, either click the board name or click the down arrow and select
Configuration. A page displaying the basic parameters will open:

Dialegic

HOME Board Conﬁguration - Detail DOCUMENTATION

Dialogic Diva 4BRI-8 PC - PORT 1, 5N:10054
@ Configuration
Board configuration » Parameter value
SIPcontral configuration D-Channel Pratocal: | ET5I - Europe/other countries, Euro-SON [ETSI-DS551) v
Password Interface mode/Resource hoard:
Direct Inward Dialing (DID):
ii ystem DID number length:
Service status
DID Collect Timeout: 2 v
Status
D-Channel Layer 2 Activation Policy: | Deactivation only by other zside | w
Board manitar
Wiew report Woice Companding: Protocol default s
View Extended Configuration Mo »

Licensing

License management

4. Select the D-Channel Protocol to which your gateway is connected, either a PSTN line or a PBX. In the
graphic.

5. Configure additional settings for the line, e.g., for the D-channel protocol QSIG you can configure the PBX
Type and configuration settings for the selected PBX. To open the online help for a specific parameter, click
the parameter and a window with the help text will pop up.

6. When you finished configuring, click Save and close the Diva SIPcontrol software web interface.
7. After the configuration is saved, restart your Dialogic® Media Gateway.
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SIP Configuration
The SIP settings are configured in the Dialogic® Diva® SIPcontrol™ software web interface.

1. To open the tool, click Start > Programs > Dialogic Diva > SIPcontrol Configuration.
Note: If you need help configuring the Dialogic® Diva® SIPcontrol™ software settings:
e click the respective parameter in the configuration tool to open a window with the help text, or

o refer to the Dialogic® 4000 Media Gateway Series Reference Guide that provides a detailed
description of all parameters.

2. Under PSTN Interface Configuration, the controllers of the Dialogic® Diva® Media Board are listed and
enabled by default. Click the check boxes under Enabled to disable the controllers you do not use. See the
graphics of the Dialogic® Media Gateway rear panels under Installation on page 12 to identify which port
corresponds to which controller.

FSTM Interface Configuration

Mame M Hardware Descrption thannels Dialplan Enabled

Gortrollert 1 Dialogic Diva 4BRI-8 PCIv2 - PORT 1 SN: 8630 2
Controller? 2 Dialogic Diva 4BRI-8 PCIv2 - PORT 2 SN: 8630 2
Controller 3 Dialogic Diva 4BRI8 PClv2 - PORT 3 SN: 8630 2
Controllers 4 Dialogic Diva 4BRI-8 PClv2 - PORT 4 SN: 8630 2

3. Go to Network Interface Configuration and set the UDP listen port and the TCP listen port of your
Ethernet adapter to:

e 5060 if the Microsoft® Mediation Server is not installed on the Media Gateway.
e 9803 if the Microsoft® Mediation Server is installed on the Media Gateway.

Metwork Interfaces
Mame Device IP address UDP listen port TCP listen port TLS listen port
|Bmadcom MNet<treme 57mx Giga | groonat?oc:‘lj;? PePdiema Erees Clgek 192.168.213.31 5060 |508E| | | | O
|Local Loopback Interface | Local Loopback Interface 127.00.1 I:I O | | ] | | a

Enable the checkbox next to the box where you entered the listen port number.

4. Configure the SIP peer settings. To do so, click SIP Peer Configuration and then click Add to open the
Edit SIP Peer Configuration window.
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SIP Configuration

Narme: |ms 0cs

Feertype:

| kS OCS 2007/2007 R2 - Mediation Server %

Host: |IF' address of Uk server

Fort

IP protocol:
Damain: |

Enhanced

Default SIP to PSTH peer:

Display name ta:
Display name fram:
User name to:

User name fram:
Gateway prefix
Reply-To expression:
Reply-Ta format:
Faorce T.38 reinvite:

Alive check:

Cause code mapping
inbound:

Cause code mapping
outhound:

Codec profile:
Maximum channels:

Early media suppoart:

Reliable provisional response:;
Security

Session Timer
Address Mormalization

Authentication
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peer default
peer default

default ¥

IIIDD!

a0

Optional %

1. Enter a name for the SIP peer configuration.
2. Select the peer type MS OCS 2007 / Mediation Server.
3. Set the Host to the IP address of your Mediation Server.

4. Enable the Default SIP to PSTN peer check box.
5. Leave the other settings at their default values.

6. Click OK to save the settings and to close the menu.
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5. Configure one routing for PSTN to SIP and one for SIP to PSTN. To do so, click Routing Configuration and
then click Add to open the Edit Routing Configuration window.

e For PSTN to SIP, enter a name and select the direction. Select the controller that should be used for this
routing and the configured SIP peer as Master. Leave the remaining settings at their default values.

Edit Routing Configuration
Marne: |PSTN-SIP-Exchange
Direction:
Select sources
Caontroller
Caontroller2
Controller3
Caontrollerd

Loadbalancing / Failover
Select destinations
Master Slave

MS-Exchange F

Max. call atternpts for this route in a failaver

El (0 =try all selected destinations)

SCenario:
ion For Condition Proc

Murnber format:

Encoding: Usze prefives
Conditions
‘ called number talling number ‘ Redirect number
|

vanipulation
Address map:

Click OK to save the settings and to close the window.
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SIP Configuration

e For SIP to PSTN, enter a name and select the direction. Select the SIP peer as source and the controller
you want to use for this routing as Master. Leave the remaining settings at their default values.

Edit Routing
Marne: |SIP-PSTN-Exchange
Direction: SIPta PSTH »
Select sources
MS-Exchange

Loadbalancing / Failover
Select destinations

Master Slave
Caontroller F
Caontroller2 F
Controller3 F
Controllerd a
gﬂca:h;?ilézaﬂempts for thiz route in a failaver EI (0= try all selected destinations)

Nurnber format
Encoding: Usze prefives

Conditions

‘ Called number Calling number ‘ Redirect number

danipulation

Address map:

Click OK to save the settings and to close the window.

6. If you have configured all settings, click Save in the main configuration page to save the settings and to
activate the changes.

For the settings in other environments, consult the user guide of your respective SIP client.

7. If you use a Microsoft® Mediation Server on the Dialogic® 4000 Media Gateway Series go to Enabling the
Microsoft® Mediation Server on page 21, before you start the service.
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Enabling the Microsoft® Mediation Server

The Dialogic® 4000 Media Gateway is a co-located Media Gateway for Microsoft® Office Communications Server
(OCS) 2007 R2; therefore, the Microsoft® Mediation Server will be running directly on this device. The device
must be part of the same domain as the OCS.

The required steps are:

1.
2.
3.

Install the Microsoft OCS 2007 and add the Dialogic 4000 Media Gateway to the same domain of the OCS.
Restart the computer and login with the account that has domain administrator rights.

Activate the Mediation Server. To do so:

¢ Right-click the Activate OCS Mediation Server link and select Run as Administrator.

e To confirm the User Account Control dialog, click Continue.

e Confirm to proceed with script by entering Y (shift-y) + Enter.

 Enter the user name of the account running the Microsoft® Mediation Server.

¢ Enter the password for this account.

Note: If the account does not exist, it will be created with the entered password.

If the activation was successful, continue with the configuration of the Mediation Server using the MMC of
OCS 2007. You will find the MMC under Start > Settings > Control Panel > Administrative Tools >
Office Communications Server.

Request, retrieve, and import a certificate from a CA (Certificate Authority) and add it to the Mediation
Server. Refer to the OCS 2007 documentation for more information about how to accomplish this.

Note: This step needs to be undertaken while you are directly logged on to the Media Gateway. It cannot
be undertaken using the MMC of the OCS 2007 on another PC in the domain.

The remaining configuration steps for setting up the Mediation Server can be done remotely by using the
MMC of the OCS 2007 on another PC in the domain.
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Enabling the Microsoft® Mediation Server

On the Mediation Server, you need to configure the IP address of the PSTN gateway to ensure proper functioning.
To do so:

1. Configure the properties of your Mediation Server in the OCS 2007 window. On the General tab, you can
see the Gateway listening IP address. Annotate this number.

renlab-dmg4013.ocs-test2.dialogic.renlab Properties

General |Next Hop Connections I Certificate I QoE I

JjJJ Mediation Server

FODN: IRENLF\B-DMG4E|13.ocs-test2.dialogic.renlab

Communications Server liskening IP address:

[192.168.212.155 |

Gakeway listening IP address:

[192.168.212.195 | Port: ISD&D

AW Edge Server:
I(None) j

Default lacation profile:

|oCs-Rz-Location
Media port range: I 60000 ko I 64000

Ok, | Cancel | Apply | Help |

2. Click the Next Hop Connections tab. Under PSTN Gateway next hop, enter the annotated IP address
and enter the port number of the Dialogic® Diva® SIPcontrol™ software.

renlab-dmg4013.ocs-test2.dialogic.renlab Properties

‘General Mext Hop Connections | Certificate | QoE |

—Office Communications Server next hop

Specify the Office Communications Server used For routing inbound
PSTM calls,

FQDMN:
vm-14,0cs-testZ, dialogic. renlab j

Pork: I 5061

—PSTN Gateway next hop

Specify the PSTH gatevsay connected to this server,

Address: | 192.168.212,195

Fart: IW
Transpart: ITCP j
Encryption level: IDD nat suppork encryplion j

Ok I Cancel | Apply | Help |
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3. Click the QoE tab and select the Dialogic Media Gateway.

This step applies only to Dialogic® 4000 Media Gateways with the Service Update 3 software and the
Microsoft® Office Communications Server R2 Mediation Server installed.

renlab-dmg4013.ocs-test2.dialogic.renlab Properties

.Generall Mex=t Hop C-:-nnectionsl Certificate  Q0E |

ok

Specify the Office Cammunications Server pool that will collect the
QoE statistics for calls that use this Mediation Server,

Poal;

oK I Cancel apply Help

4. Click OK to close the dialog box.
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Backing up and Restoring the Configuration

Backing up and Restoring the Configuration

The Dialogic® 4000 Media Gateways provide a restore and backup menu. You can access this menu if you press
the left ALT key during the boot sequence. The menu provides the following options:

Dialogic 4000 Media Gateway Series: System Recovery

=
I}ﬁ Restare to factory defaults
ﬁi“ Create Backup

S

[

7
g Restare previous backup
=

@ Feboot

Dialezgic

Systern will be restarted after 22:33:55

Restore to factory defaults: The configuration is set to default factory settings with which the Media Gateway
was delivered. If you choose this option and you accept to restore the factory defaults, all current settings will
be lost.

Create backup: An image of all settings is created and stored under D:/backup. The backup is overwritten
every time you create a new backup. If you need to keep a backup with certain settings, save it in a different
directory or on an external medium.

Restore previous backup: With this option, you can restore a previously saved backup. This might be necessary
if you need re-activate the settings of a configuration you saved earlier. If you choose this option, all current
settings will be lost.

Reboot: Restarts the Media Gateway.

If you do not choose any of the settings, the Media Gateway will be restarted after the time, displayed at the
bottom of the dialog box, has elapsed.
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LED Indicators and Switches

The following LED indicators and switches are integrated in the front panel of the Media Gateway:

1 2 3 4 5

G 7o
LED/Switch | Function Color Status Description
1 Power LED green off Power off or power source disrupted
lit Power on
2 Status LED green lit Normal activity
flashing Degraded operation
orange lit Critical fault
flashing Non-critical fault
3 Disk Activity LED | green lit HDD activity
orange lit HDD fault (non-critical)
red lit Critical fault
4 NIC Activity LED | green lit No fault
5 ID LED blue lit Used to identify a particular system
6 Power Switch
7 Reset Switch
8 NMI Switch
9 ID Switch
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Technical Specifications

Technical Specifications
Environmental requirement:

Operating temperature: 10 degrees Celsius to 35 degrees Celsius

Dialogic® 4000 Media Gateways

CPU Intel Xeon 5160 Dual Core processor; 3.0GHz

Memory 2 GB DDR2 ECC SDRAM (667MHz)

Dimensions in mm

Height: 44

Width: 430

Length: 508

External interface 3 USB (2.0) ports
VGA port

RS232 Serial port
4 x Gigabit-Ethernet ports

Internal interface 64 bit; PCI (3.3 V)

Power supply 2 power supplies; each with:
100-240 Vac
50/60 Hz
4/2 A

Replacing a Power Supply Module
To replace the power supply module (PSM), do the following:

1. If you have two power supply modules, verify which one has failed. The LED next to the green handle is lit
red if the PSM failed.

2. Disconnect the power cord.

Note: You need to disconnect the power cord only of the PSM that failed. The power cord of the functioning
PSM can remain plugged.

3. Slide the green safety lock to the left.
4. Grasp the green handle and pull the PSM out.

5. Take the new PSM and insert it into the box. Make sure to keep the green safety lock pressed to the left
while inserting the PSM.
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International Regulatory Information

Regulatory Information for Europe

WARNING Thisis a class A product. In a domestic environment this product may cause radio interference
. in which case the user may be required to take adequate measures.

c € COMPLIANCE

All Diangic® 4000 Media Gateways are certified in Europe (C€ mark).

Approval in Europe includes only countries that accept European Union approval (C€ mark): Austria, Belgium,
Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece, Hungary, Iceland, Ireland, Italy,
Latvia, Lithuania, Luxembourg, Malta, Netherlands, Norway, Poland, Portugal, Slovakia, Slovenia, Spain, Sweden,
Switzerland, and United Kingdom.

Some other countries in Eastern Europe and the Mediterranean region also accept the CE-mark. If you are
unsure, please check with your equipment supplier, service provider or regulatory authority for confirmation.

The Dialogic® products covered by this notice meet the following European Directives:

2006/95/EC Safety/Low Voltage Directive
2004/108/EC EMC Directive
99/05/EC R&TTE Directive

To achieve CE compliance, be sure to select a host that already meets the EMC and Low Voltage Directives before
the addition of any optional board. Remember that the use of option boards declared compliant with the Directives
by their manufacturer only gives "presumption of compliance" for the whole system. It is the responsibility of
the system supplier to verify that the requirements of the listed Directives are still met by the final system, as
supplied to the end-user. System integrators should take notice of further conditions expressed in this section
and the Safety section.

Dialogic® Diva® BRI Media Boards

The products covered by this notice have been successfully tested against TBR 3 basic call control. Application
developers implementing supplementary services at application level must ensure that their implementation
complies with the services offered by the local Public Switched Telephone Network (PSTN) operator. In case of
doubt, network specifications must be consulted; the R&TTE Directive imposes that each PSTN operator makes
such specifications available.

Inter-working is guaranteed only with Public Switched Telephone Networks (PSTNs) offering Basic Rate Access
conforming to EuroISDN specifications.

Before any connection to PSTN offering other Basic Rate Access to other national or international BRI standards,
please consult your Dialogic representative for standards other than EuroISDN.

Dialogic® Diva® PRI Media Boards

The products covered by this notice have been successfully tested against TBR 4 basic call control. Application
developers implementing supplementary services at application level must ensure that their implementation
complies with the services offered by the local Public Switched Telephone Network (PSTN) operator. In case of
doubt, network specifications must be consulted; the R&TTE Directive imposes that each PSTN operator makes
such specifications available.

Inter-working is guaranteed only with Public Switched Telephone Networks (PSTNs) offering Primary Rate Access
conforming to EuroISDN specifications.

Before any connection to PSTN offering Primary Rate Access to other national or international E1 standards,
please consult your Dialogic representative.

page 27



International Regulatory Information

Dialogic® Diva® Analog Media Boards

This equipment has been tested against TBR 21 requirements (January 1998 edition - Terminal Equipment (TE)
capable of 2-wire access to an analogue Public Switched Telephone Network (PSTN), that is capable of originating
a circuit-switched call using Dual Tone Multi Frequency (DTMF) signaling and/or receiving an incoming
circuit-switched call).

Due to differences among the individual PSTNs provided in different countries, compliance to TBR 21 does not,
of itself, give an unconditional assurance of successful operation on every PSTN network termination point.

In the event of problems, you should first contact your equipment supplier.

Conditions for TBR3, TBR4, and TBR 21 Compliance

To comply with the TBRs, be sure to adhere to the following requirements:

e The appropriate parameter file must be installed on the system and enabled on these products. To do so:

1. Click Start > Programs > Dialogic Diva > SIPcontrol configuration.

2. In the Dialogic® Diva® SIPcontrol™ Software web interface, click Board configuration.

3. Click the Dialogic® Diva® Media Board, and in the Board Configuration - Detail select your
country-specific protocol from the dropdown menu next to D-Channel Protocol.

2] HOME Board Configuration - Detail

Dialogic Diva Analog-8 PCl w1, SMN:1216

@ Configuration
Board configuration b Parameter Value
SIPcontrol configuration D-Channel Protocal: TER21 - Europedother countries -1
Password i

I

USA-CAN - U54/Canada
DEMNMARE. - Denmark.
SWEDEN - Sweden
UAE - United Arabian Emirates b

Usze Caller D {CI0:

Trunk Dialing Made:

ii System Wait for dial tone: Eﬁg?ggmﬂgis-t[iﬁ;herlands
Service status Yoice Companding: tipfﬂg[;fg:gin

SOUTH-KOREA - South Korea
CHIMA - China b

Status

Note: The above graphic shows the parameters and values for Diva Analog Media Board configuration. The
available D-channel protocols depend on the installed Diva Media Board. The menu options for Diva BRI and
PRI Media Boards are slightly different.

e These products do not perform automatically repeated call attempts; however, they do not include protection
against repeated call requests from the controlling application software.

e To meet the requirements of TBR 21 § 4.8.3, the application software shall not submit call requests that
violate the following rules:

e The number of repeated call attempts [to the same number] is restricted to 15.

Software update

View Extended Configuration

e The interval between subsequent call attempts [to the same number] is at least 5 seconds.
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EU Declaration of Conformity

Dialogic Corporation declares that this equipment is in compliance with the Radio and Telecommunication
Terminal Equipment directive 1999/5/EC with requirements covering the Electromagnetic Compatibility Directive
89/336/EEC and the Low Voltage Directive 2006/95/EC. A detailed declaration of conformity for this product can
be found at: http://www.dialogic.com/declarations

Manufacturer's office in European Union:
Dialogic Distribution Limited

Unit 4034

Citywest Business Campus

Saggart, Co. Dublin

IRELAND

Tel: +353 1 630 9000

Fax: +353 1 630 9099

CS:Dialogic timto prohlasuje, Ze tento ITE je ve shodé se zakladnimi pozadavky a dalSimi pfislusnymi ustanovenimi smérnice
1999/5/ES.

DA:Undertegnede Dialogic erklzerer herved, at fglgende udstyr ITE overholder de vaesentlige krav og gvrige
relevante krav i direktiv 1999/5/EF.

DE: Hiermit erklart Dialogic, dass sich das Geré&t ITE in Ubereinstimmung mit den grundlegenden Anforderungen
und den Ubrigen relevanten Bestimmungen der Richtlinie 1999/5/EG befindet.

EL:ME THN NAPOYZA Dialogic AHAQNEI OTI /TE ZYMMOPOONETAI MPOX TIZ OYZIQAEIZ AMAITHZEIZ Al TIXZ AOINEZ
ZXETI EZ AIATAZEIX THZ OAHIAZ 1999/5/EK.

EN:Hereby, Dialogic, declares that this ITE is in compliance with the essential requirements and other relevant
provisions of Directive 1999/5/EC.

ES:Por medio de la presente Dialogic declara que el ITE cumple con los requisitos esenciales y cualesquiera otras
disposiciones aplicables o exigibles de la Directiva 1999/5/EC.

ET:K&esolevaga kinnitab Dialogic seadme ITE vastavust direktiivi 1999/5/EU p&hinuetele ja nimetatud
direktiivist tulenevatele teistele asjakohastele sdtetele.

FI:Dialogic vakuuttaa taten ettd ITE tyyppinen laite on direktiivin 1999/5/EY oleellisten vaatimusten ja sita
koskevien diretiivin muiden ehtojen mukainen.

FR:Par la présente Dialogic déclare que |'appareil ITE est conforme aux exigences essentielles et aux autres
dispositions pertinentes de la directive 1999/5/CE.

HU:Alulirott, Dialogic nyilatkozom, hogy a ITE megdfelel a vonatkozd alapvetd kdvetelményeknek és az 1999/5/EC
iranyelv egyéb eldirasainak.

IC:Hér med lysir Dialogic yfir pvi ad ITE er i samraemi vid grunnkrofur og adrar krofur, sem gerdar eru i tilskipun
1999/5/EC.

IT:Con la presente Dialogic dichiara che questo ITE & conforme ai requisiti essenziali ed alle altre disposizioni
pertinenti stabilite dalla direttiva 1999/5/CE.

LT:Siuo Dialogic deklaruoja, kad Sis ITE atitinka esminius reikalavimus ir kitas 1999/5/EB Direktyvos nuostatas.
LV:Ar So Dialogic deklaré, ka ITE atbilst Direktivas 1999/5/EK bdatiskajam prasibam un citiem ar to saistitajiem noteikumiem.

MT: Hawnhekk. Dialodic, jiddikjara |i dan ITE jikkonforma mal-htigijiet essenzjali u ma provvedimenti ofirajn relevanti li hemm
fid-Dirrettiva 1999/5/EC.

NL:Hierbij verklaart Dialogic dat het toestel ITE in overeenstemming is met de essentiéle eisen en de andere
relevante bepalingen van richtlijn 1999/5/EG.

NO:Dialogic erklzerer herved at utstyret ITE er i samsvar med de grunnleggende krav og gvrige relevante krav
i direktiv 1999/5/EF.

PL:Dialogic niniejszym o$wiadcza, ze ITE spetnia wszystkie istotne wymagania i odpowiednie ustalenia dyrektywy 1999/5/EC.
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International Regulatory Information

PT:Dialogic declara que este ITE estda conforme com 0s requisitos essenciais e outras disposicdes da Directiva
1999/5/CE.

SL:Dialogic izjavlja, da je ta ITE v skladu z bistvenimi zahtevami in ostalimi relevantnimi dologili direktive 1999/5/ES.
SK:Dialogic tymto vyhlasuje, Ze ITE spifia zédkladné poZiadavky a vSetky prislugné ustanovenia Smernice 1999/5/ES.

SV:Harmed intygar Dialogic att denna ITE stdr | 6verensstammelse med de vésentliga egenskapskrav och évriga
relevanta bestammelser som framgar av direktiv 1999/5/EG.

Product Environmental Information

In August 2005, the European Union Directive on Waste Electrical and Electronic Equipment (2002/96/EC) and
its amendment (2003/108/EC), collectively known as the WEEE Directive, came into force throughout most of
the European Union. This Dialogic product comes within the scope of the WEEE Directive.

We are confident that this product will provide you with many years of reliable service. Ultimately, a time may
come when the product will no longer meet your needs or will become un-economical to repair. It is at that stage
that we ask for your co-operation in recycling this product in the spirit of the WEEE directive.

While Dialogic has taken great care to minimize the environmental burden of this product by careful design and
manufacturing, we ask you to help us to further minimize the environmental burden of this product by recycling

it. Please do not dispose of this product through municipal or general waste systems because it contains materials
that can be economically recycled.

Like all electrical and electronic equipment, including televisions and computers, it may contain small amounts
of materials which could lead to environmental damage. To minimize any environmental damage we ask you to
have this product recycled by:

e bringing it to the recycling collection point in your company
e by handing it into the store where you are purchasing the replacement
e by delivering it to a local bring-center in your area.

No charge can be imposed on you for this recycling service in the
European Union as Dialogic has paid for recycling this product when
it was placed on the market. These are requirements of the WEEE
Directive. We thank you in advance for your cooperation and for
working with Dialogic to protect our environment.
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Regulatory Information for the USA

WARNING: Changes or modifications to this unit not expressly approved by Dialogic Corporation could void
. the user's authority to operate the equipment.

FCC Part 15 Statement

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference
when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause
harmful interference in which case the user will be required to correct the interference at his own expense.

FCC Part 68 Notice
This equipment complies with Part 68 of the FCC rules and the requirements adopted by the ACTA.

On the bottom of this equipment is a label that contains, among other information, a FCC part 68 registration
number or a product identifier in the format US: AAAEQ# #TXXXX. If requested, this information must be provided
to the telephone company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must comply with
the applicable FCC part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular
plug is provided with this product. It is designed to be connected to a compatible modular jack that is also
compliant.

The REN is used to determine the number of devices that may be connected to a telephone line. Excessive RENs
on a telephone line may result in the devices not ringing in response to an incoming call. In most but not all
areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices that may be connected
to a line, as determined by the total RENs, contact the local telephone company.

If this equipment causes harm to the telephone network, the telephone company will notify you in advance that
temporary discontinuance of service may be required. But if advance notice is not practical, the telephone
company will notify the customer as soon as possible. Also, you will be advised of your right to file a complaint
with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations, or procedures that could
affect the operation of the equipment. If this happens, the telephone company will provide advance notice in
order for you to make the necessary modifications in order to maintain uninterrupted service.

If trouble is experienced with this equipment, please contact us for repair and warranty information. If the trouble
is causing harm to the telephone network, the telephone company may request you to remove the equipment
from the network until the problem is resolved.

Dialogic

1515 Route 10
Parsippany

NJ 07054

Tel: (973) 967-6000

This unit contains no user-serviceable parts.

Connection to party lines is subject to state tariffs. Contact the state public utility commission, public service
commission or corporation commission for information.

page 31



International Regulatory Information

Dialogic® Diva® Basic Rate Interface (BRI) Media Boards:

Facility Digital Reg. | Service USOC Jack
Interface code Order code |Type
code

Without Fax |02IS5 XD 6.0N N/A

option

With Fax 02IS5 XD 6.0P N/A

option

Dialogic® Diva® Primary Rate Interface (PRI) Media Boards:

Facility Interface code

Digital Reg. code

Service Order code

USOC Jack Type

04DU9-1SN

DD

6.0F

RJ48-C

Dialogic® Diva® Analog Media Boards:

REN

USOC Jack Type

Diva Analog-2
Diva Analog-4
Diva Analog-8

Diva UM-Analog-2
Diva UM-Analog-4
Diva UM-Analog-8

0.2B

RJ11-C

Diva Analog-2 PCle
Diva Analog-4 PCle
Diva Analog-8 PCle

Diva UM-Analog-2 PCle
Diva UM-Analog-4 PCle
Diva UM-Analog-8 PClIe

0.1B

RJ11-C

Fax Branding

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other
electronic device to send any message via a telephone fax machine unless such message clearly contains in a
margin at the top or bottom of each transmitted page or on the first page of the transmission, the date and time
it is sent and an identification of the business or other entity, or other individual sending the message and the
telephone number of the sending machine or such business, other entity, or individual. The telephone number
provided may not be a 900 number or any other number for which charges exceed local or long-distance

transmission charges.

It is the responsibility of the end user or developer to ensure that the regulations set forth in the preceding
paragraph are followed. Application developers must provide support for fax branding in the applications they
develop and inform users of their responsibility under the Act along with instructions for use. Developers can
find instructions for setting up a fax header in the Dialogic® software reference manual. End users should consult
the documentation that is provided with their computer telephony application for instructions on fax branding

identification.
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Regulatory Information for Canada
Notice: This equipment meets the applicable Industry Canada Terminal Equipment Technical Specifications.
This Class A digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.

The Ringer Equivalence Number (REN) is an indication of the maximum number of devices allowed to be
connected to a telephone interface. The termination on an interface may consist of any combination of devices
subject only to the requirement that the sum of the RENs of all the devices does not exceed 5.

Dialogic® Diva® Analog Media Boards
The Dialogic® 4000 Media Gateway model DMG4008LS has a REN of 0.2.

Regulatory Information for Australia

Dialogic is required to provide the following information as a condition of the telecommunications conformity of
Dialogic® telecommunications products. You may also be responsible for meeting requirements other than those
outlined in this document.

Note: Failure to meet the requirements listed may render the products non-compliant, with the user liable to
significant penalties under the Telecommunications Act.

CAUTION: This equipment must be installed and serviced by qualified personnel. No user accessible parts

' inside.
Dialogic® Diva® BRI Media Boards

Do not connect these products directly to a telecommunications network. These products must be connected to
a network terminating unit (NTU) or some other device that provides line isolation. This allows the carrier's
telecommunications network to be electrically isolated from the product and host PC.

These products are only to be connected to safety extra low voltage circuits. These products should only be
connected to the safety extra low voltage (SELV) port of the network termination unit (NTU) or PBX that is
providing the E-1 interface.

Dialogic® Diva® PRI Media Boards

These products must be installed and serviced by suitably qualified personnel. These products must only be
installed by personnel that understand the electrical safety implications of connecting the products to other
equipment. In particular, the installer must understand the definition of a telecommunications network and safety
extra low voltage circuits.

Dialogic® Diva® Analog Media Boards
These products shall be used in a manner that complies with the technical standard AS/ACIF S002:

e The application software shall answer an incoming call by seizing the line at least 2 seconds after the start
of an application of ring signal from a PSTN. A maximum time of 15 seconds is recommended.

e The application software shall comply with the following requirements before the commencement of dialing:

e When dial tone detection is enabled, the application software may commence dialing after the presence of
dial tone is validated.

o If dial tone detection is not enabled or if dial tone is not detected, the application software shall commence
dialing no less than 2 seconds after the line is seized.

e A total of 10 call attempts are allowed to a telephone number, with a minimum period of 2 seconds between
calls. If the call does not connect after 10 attempts, 30 minutes must expire before automatic redialing may
be initiated.

e These products must connect to the telecommunications network only by means of cables that meet applicable
ACA standards and telecommunications conformity.
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These products must only be used in a data terminal equipment (DTE), e.g., computer, that has a screw-down

cover or lid. Because unsafe voltages (TNV) exist on these products, disconnect the product from the telephone
line while the cover of the DTE is removed.

These products will not automatically put the channel back to the on-hook state when the calling party hangs
up. The application is tasked to handle this function on the detection of a disconnect tone or loop current drop.

e These products will be inoperable when mains power fails.
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Suppliers Declaration of Conformity

The latest versions of the Declaration of Conformity are available at www.dialogic.com/declarations.

Dialzgic

Declaration of Conformity
No: DO063

Revision 01

The equipment described below is declared to be in conformity with the following applicable national and international standards. The
conformity is valid ONLY when the equipment is used in a manner consistent with the manufacturer's recommendations and the

reference documents.

Equipment Type(s): Dialogic 4060 Media Gateway
Dialogic 4120 Media Gateway

Document No / Edition /Date

Title

IEC 60950-1 — 1* Edition (2001-10)

Safety of Information Technology Equipment

UL/CSA 60950-1 — 1% Edition (2003)

Safety of Information Technology Equipment

EN 60950-1: 2001

Safety of Information Technology Equipment (see additional information)

AS/NZS 60950: 2000, Al: 2003

Safety of Information Technology Equipment

EN 55022: 1998, Class A Limit

Information Technology Equipment - Radio Disturbance Characteristics

EN 55024: 1998

Information Technology Equipment - Immunity Characteristics

FCC, 47 CFR Part 15, Class A digital device

Radio Frequency Devices - Subpart B - Unintentional Radiators

ICES-003 Issue 4 - Feb 2004, Class A

Interference-Causing Equipment Standards - Digital Apparatus

Additional information:

The reference for Internal cards telecom information is from declaration D0018

Australia test reports:

Futjisu/Siemens report CER+EIC04-0004+E01, dated 26/10/2004 covers EN55022

Futjisu/Siemens report CER+EIC06-0005+S01, dated 11/07/2004 covers AS/NZS 60950

Eicon internal report, dated 19/01/2006 and TBR4 layer 1 report # 3-4143-1-2/04 from Cetecom, dated
03/11/2004 and layer 2, 3 report 98/164/HJ from Deutsche Telekom AG, dated 30/07/1998 covers AS/ACIF S038

Regions:

European Economic Area (EEA): Dialogic Corporation (address below) declares the equipment in compliance with the essential requirements of EC Council
Directives: 1999/5/EC - R&TTE: 2006/95/EC - Safety/LVD: 89/336/EEC — EMC

ISDN PRI Internal cards registrations:

USA: Dialogic Corporation (address below) make this SDoC as Responsible Party for equipment registered with ACTA as number: US: E3SDDNAN800-820

Canada: Dialogic Corporation (address below) is the Declaring Party for equipment registered with Industry Canada as number: IC: 885E-803016

Australia / New Zealand: Supplier Code N964 [Dialogic Pty Ltd. Level 12, 1 Pacific Highway North Sydney NSW 2060] ACN: 064 824 899

Any other region where the Regulatory Requirements are satisfied by compliance to the standards declared above.

This Declaration of Conformity is issued by Dialogic Corporation, which is solely responsible for the declared compliance.

Company Address:

Dialogic Corporation
9800 Cavendish 5" floor
Montreal, Quebec
Canada, H4M 2V9

Authorized signature, name and function:
ﬁg{ ZU
Gaeten Hogue -

Approvals Manager
Date: 10, September, 2007

Dialogic Distribution Limited, our location in Europe operates from:
Unit 4034 Kingswood Avenue Citywest Business Campus, Saggart, Co. Dublin, Ireland.

Copies of this Declaration of Conformity may be downloaded at http://www.dialogic.com/declarations
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Declaration of Conformity

Dia]egic. No: D0015

Revision 01

The equipment described below is declared to be in conformity with the following applicable national and international standards. The
conformity is valid ONLY when the equipment is used in a manner consistent with the manufacturer’'s recommendations and the
reference documents.

Equipment Type(s): Diva 4-BRI

Document No / Edition /Date Title

IEC 60950 — 3 Edition (1999) Safety of Information Technology Equipment

EN 60950-1: 2001 Safety of Information Technology Equipment

FCC, 47 CFR Part 15, Class B digital device Radio Frequency Devices - Subpart B - Unintentional Radiators

ICES-003 Issue 4 - Feb 2004, Class B Interference-Causing Equipment Standards - Digital Apparatus

EN 55022: 1998, Class B Limit Information Technology Equipment - Radio Disturbance Characteristics

EN 55024: 1998 Information Technology Equipment - Immunity Characteristics

47 CFR part 68, subpart D Technical Requirements for Connection of Terminal Equipment to the Telephone Network
CS-03 Issue 8 Part VI Specification for Terminal Equipment, Terminal Systems, Network Protection Devices, Connection Arrangements
TBR3: Nov 95, Al: Dec 97 Attachment requirements for terminal equipment to connect to a ISDN using ISDN basic access
AS/NZS 60950: 2000, Al: 2003 Safety of Information Technology Equipment

AS/ACIF S031: 2001 Requirements for ISDN Basic Access Interface

Additional information:

Australia test reports: Futjisu/Siemens report # EICOE004-1, dated 22/03/2001 covers EN55022

Nemko report # 6S65295AU1, dated 05/29/2006 covers AS/NZS 60950

Eicon internal report, dated 16/11/2001 and TBR3 layer 1, 2, 3 report # 01/01780/2/UVZ from Deutsche Telekom
AG, dated 27/04/2001 covers AS/ACIF S031

Regions:

European Economic Area (EEA): Dialogic Corporation (address below) declares the equipment in compliance with the essential requirements of EC Council
Directives: 1999/5/EC - R&TTE: 2006/95/EC - Safety/LVD: 89/336/EEC — EMC

USA: Dialogic Corporation (address below) make this SDoC as Responsible Party for equipment registered with ACTA as number: Reg. no: E3SCAN-40181-XD-N

Canada: Dialogic Corporation (address below) is the Declaring Party for equipment registered with Industry Canada as number: IC: 885E-803008

Australia / New Zealand: Supplier Code N964 [Dialogic Pty Ltd. Level 12, 1 Pacific Highway North Sydney NSW 2060] ACN: 064 824 899

Any other region where the Regulatory Requirements are satisfied by compliance to the standards declared above.

This Declaration of Conformity is issued by Dialogic Corporation, which is solely responsible for the declared compliance.

Company Address: Authorized signature, name and function:

Dialogic Corporation
9800 Cavendish 5™ floor o~
Gaeten Hogue -

Montreal, Quebec Approvals Manager
Canada, H4M 2V9 Date: 25, January, 2007

Dialogic Distribution Limited, our location in Europe operates from:
Unit 4034 Kingswood Avenue Citywest Business Campus, Saggart, Co. Dublin, Ireland.

Copies of this Declaration of Conformity may be downloaded at http://www.dialogic.com/declarations
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Dialzgic

Declaration of Conformity
No: D0016

Revision 01

The equipment described below is declared to be in conformity with the following applicable national and international standards. The
conformity is valid ONLY when the equipment is used in a manner consistent with the manufacturer's recommendations and the

reference documents.

Equipment Type(s): Diva PRI/E1-30, Diva V-PRI/E1-30
Diva PRI/T1-24, Diva V-PRI/T1-24

Document No / Edition /Date

Title

IEC 60950-1: 2001

Safety of Information Technology Equipment

UL/CSA 60950-1 — 1% Edition (2003)

Safety of Information Technology Equipment

EN 60950-1: 2001

Safety of Information Technology Equipment

FCC, 47 CFR Part 15, Class B digital device

Radio Frequency Devices - Subpart B - Unintentional Radiators

ICES-003 Issue 4 - Feb 2004, Class B

Interference-Causing Equipment Standards - Digital Apparatus

EN 55022: 1998, Class B Limit

Information Technology Equipment - Radio Disturbance Characteristics

EN 55024: 1998

Information Technology Equipment - Immunity Characteristics

47 CFR part 68, TIA-968-A

Technical Requirements for Connection of Terminal Equipment to the Telephone Network

CS-03 Issue 8 Part VI

Specification for Terminal Equipment, Terminal Systems, Network Protection Devices, Connection Arrangements

TBR4: Nov 95, Al: Dec 97

Attachment requirements for terminal equipment to connect to an ISDN using ISDN primary rate access

AS/NZS 60950: 2000,A1: 2003

Safety of Information Technology Equipment

AS/ACIF S038: 2001

Requirements for ISDN Primary Rate Access Interface

Additional information:

Australia test reports:

Futjisu/Siemens report EMI+EIC02-0002+E01, dated 07/04/2001 covers EN55022

Nemko report 6S65295AU1, dated 05/29/2006 covers AS/NZS 60950

Eicon internal report, dated 16/11/2001 and TBR4 layer 1 from Cetecom, dated 28/06/2005 and layer 2, 3 report
98/164/HJ from Deutsche Telekom AG, dated 30/07/1998 covers AS/ACIF S038

NZ test report

Nemko report 5744740, dated May 11,2005 covers Layer 3 supplementary testing

Regions:

European Economic Area (EEA): Dialogic Corporation (address below) declares the equipment in compliance with the essential requirements of EC Council
Directives: 1999/5/EC - R&TTE: 2006/95/EC - Safety/LVD: 89/336/EEC — EMC

USA: Dialogic Corporation (address below) make this SDoC as Responsible Party for equipment registered with ACTA as number: US: E3SDDNANS800-810

Canada: Dialogic Corporation (address below) is the Declaring Party for equipment registered with Industry Canada as number: IC: 885E-803003

Australia / New Zealand: Supplier Code N964 [Dialogic Pty Ltd. Level 12, 1 Pacific Highway North Sydney NSW 2060] ACN: 064 824 899

Any other region where the Regulatory Requirements are satisfied by compliance to the standards declared above.

This Declaration of Conformity is issued by Dialogic Corporation, which is solely responsible for the declared compliance.

Company Address:

Dialogic Corporation
9800 Cavendish 5" floor
Montreal, Quebec
Canada, H4M 2V9

Authorized signature, name and function:

Gael%—iégApprovals Manager

Date: 25, January, 2007

Dialogic Distribution Limited, our location in Europe operates from:
Unit 4034 Kingswood Avenue Citywest Business Campus, Saggart, Co. Dublin, Ireland.

Copies of this Declaration of Conformity may be downloaded at http://www.dialogic.com/declarations
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Dialegic.

Declaration of Conformity
No: DO018

Revision 01

The equipment described below is declared to be in conformity with the following applicable national and international standards. The
conformity is valid ONLY when the equipment is used in a manner consistent with the manufacturer’'s recommendations and the

reference documents.

Equipment Type(s):

Diva 2-PRI, V-2PRI

Diva 4-PRI, V-4PRI

Document No / Edition /Date

Title

IEC 60950-1: 2001

Safety of Information Technology Equipment

UL/CSA 60950-1 — 1* Edition (2003)

Safety of Information Technology Equipment

EN 60950-1: 2001

Safety of Information Technology Equipment

FCC, 47 CFR Part 15, Class B digital device

Radio Frequency Devices - Subpart B - Unintentional Radiators

ICES-003 Issue 4 - Feb 2004, Class B

Interference-Causing Equipment Standards - Digital Apparatus

EN 55022: 1998, Class B Limit

Information Technology Equipment - Radio Disturbance Characteristics

EN 55024: 1998

Information Technology Equipment - Immunity Characteristics

TIA-968-A: Oct 2002, A1: July 2003, A2: Jan
2003, A3: Dec 9, 2004

Technical Requirements for Connection of Terminal Equipment to the Telephone Network

CS-03 Issue 9 Part VI: Nov 2004

Specification for Terminal Equipment, Terminal Systems, Network Protection Devices, Connection Arrangements

TBR4: Nov 95, Al: Dec 97

Attachment requirements for terminal equipment to connect to an ISDN using ISDN primary rate access

AS/NZS 60950: 2000, Al: 2003

Safety of Information Technology Equipment

AS/ACIF S038: 2001

Requirements for ISDN Primary Rate Access Interface

Additional information:

Australia test reports:

Futjisu/Siemens report CER+EIC04-0004+E01, dated 26/10/2004 covers EN55022

Futjisu/Siemens report CER+EIC06-0005+S01, dated 11/07/2004 covers AS/NZS 60950

Eicon internal report, dated 19/01/2006 and TBR4 layer 1 report # 3-4143-1-2/04 from Cetecom, dated
03/11/2004 and layer 2, 3 report 98/164/HJ from Deutsche Telekom AG, dated 30/07/1998 covers AS/ACIF S038

Regions:

European Economic Area (EEA): Dialogic Corporation (address below) declares the equipment in compliance with the essential requirements of EC Council
Directives: 1999/5/EC - R&TTE: 2006/95/EC - Safety/LVD: 89/336/EEC — EMC

USA: Dialogic Corporation (address below) make this SDoC as Responsible Party for equipment registered with ACTA as number: US: E3SDDNAN800-820

Canada: Dialogic Corporation (address below) is the Declaring Party for equipment registered with Industry Canada as number: IC: 885E-803016

Australia / New Zealand: Supplier Code N964 [Dialogic Pty Ltd. Level 12, 1 Pacific Highway North Sydney NSW 2060] ACN: 064 824 899

Any other region where the Regulatory Requirements are satisfied by compliance to the standards declared above.

This Declaration of Conformity is issued by Dialogic Corporation, which is solely responsible for the declared compliance.

Company Address:

Dialogic Corporation
9800 Cavendish 5" floor
Montreal, Quebec
Canada, H4M 2V9

Authorized signature, name and function:

Gaemﬁ/%pprovals Manager

Date: 25, January, 2007

Dialogic Distribution Limited, our location in Europe operates from:
Unit 4034 Kingswood Avenue Citywest Business Campus, Saggart, Co. Dublin, Ireland.

Copies of this Declaration of Conformity may be downloaded at http://www.dialogic.com/declarations
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Dialzgic

Declaration of Conformity
No: D0020

Revision 03

The equipment described below is declared to be in conformity with the following applicable national and international standards. The
conformity is valid ONLY when the equipment is used in a manner consistent with the manufacturer's recommendations and the

reference documents.

Equipment Type(s): Diva Analog-4
Diva Analog-8

Document No / Edition /Date

Title

IEC 60950-1: 2001

Safety of Information Technology Equipment

UL/CSA 60950-1 — 1% Edition (2003)

Safety of Information Technology Equipment

EN 60950-1: 2001

Safety of Information Technology Equipment

EN 55022: 1998, Class B Limit

Information Technology Equipment - Radio Disturbance Characteristics

EN 55024: 1998

Information Technology Equipment - Immunity Characteristics

FCC, 47 CFR Part 15, Class B digital device

Radio Frequency Devices - Subpart B - Unintentional Radiators

ICES-003 Issue 4 - Feb 2004, Class B

Interference-Causing Equipment Standards - Digital Apparatus

47 CFR part 68, TIA/EIA/IS-968

Technical Requirements for Connection of Terminal Equipment to the Telephone Network

CS-03 Issue 8 Part |

Specification for Terminal Equipment, Terminal Systems, Network Protection Devices, Connection Arrangements

TS 103 021: Aug 2003

Access and terminals (AT): Harmonized basic attachment requirements for Terminals for connection to analogue
interfaces of the Telephone Networks: Update of the technical contents of TBR21, TBR015, TBR17, EN 301 437

AS/NZS 60950: 2000, Al: 2003

Safety of Information Technology Equipment

AS/ACIF S002: 2001

Analogue interworking and non-interference requirements for Customer Equipment for connection to the Public
Switched Telephone Network

Additional information:

Australia test reports:

Futjisu/Siemens report CER+EIC04-0005+E01, dated 19/11/2004 covers EN55022

Nemko report 4527513AU1, dated 07/10/2004 covers AS/NZS 60950

Nemko report 4727513 issue 3, dated 24/11/2004 covers AS/ACIF S002

Regions:

European Economic Area (EEA): Dialogic Corporation (address below) declares the equipment in compliance with the essential requirements of EC Council
Directives: 1999/5/EC - R&TTE: 2006/95/EC - Safety/LVD: 89/336/EEC — EMC

USA: Dialogic Corporation (address below) make this SDoC as Responsible Party for equipment registered with ACTA as number: US: E3SMM02B800-824

Canada: Dialogic Corporation (address below) is the Declaring Party for equipment registered with Industry Canada as number: IC: 885E-803015

Australia: Supplier Code N964 [Dialogic Pty Ltd. Level 12, 1 Pacific Highway North Sydney NSW 2060] ACN: 064 824 899

Any other region where the Regulatory Requirements are satisfied by compliance to the standards declared above.

This Declaration of Conformity is issued by Dialogic Corporation, which is solely responsible for the declared compliance.

Company Address:

Dialogic Corporation
9800 Cavendish 5™ floor
Montreal, Quebec
Canada, H4M 2V9

Authorized signature, name and function:

o

Gaetdn Hogue - Approvals Manager
Date: 15, January, 2008

Dialogic Distribution Limited, our location in Europe operates from:
Unit 4034 Kingswood Avenue Citywest Business Campus, Saggart, Co. Dublin, Ireland.

Copies of this Declaration of Conformity may be downloaded at http://www.dialogic.com/declarations
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